PC JIMS CASE VIEWER
Note: As of 03/13/2018 and in version 1.42.23 and higher, the following changes were made to this program:
1.

2.

The event calendar has a new option under the Edit/Preferences menu to view the program in a landscape view.
This was done because we encountered some trouble with pc's that were set to a larger resolution. In the
landscape view, the cases and events will display to the right of the calendar, instead of at the bottom.
The Support Tab of the Lady Justice screen can now be used to record an email address for the signed on user.
This email address will be used to verify a user's access to secured cases through the Judici tab of the Case Viewer
screen. In order for this to work, we are going to be offering all counties Extended Access free of charge. If your
county hasn’t been set up yet, you will not see secured documents through the case viewer.

For many years, the Case Management Hub has been the center for all case related activity. Users would locate their case
and use the various hub options to perform the data‐entry tasks necessary to process a case. This worked fine, but took
more time to go in and out of programs and never gave the user one central place where it was easy to see all of the case‐
related data. It also was not as user friendly to court personnel who weren't trained to use PC JIMS. After listening to
input from several judges who used PC JIMS and Judici, we decided we needed a program in PC JIMS that presented data
in much the same way that Judici does‐‐with one central case location and separate tabs for each kind of case data. Thus
the Case Viewer was created, giving judges and clerk staff an easy way to access all of the case data, as well as data for a
litigant's other cases, both in‐county or out‐of‐county.

ACCESSING THE CASE VIEWER FROM THE CASE MANAGEMENT HUB
You can access the Case Viewer from two places. Firstly, we added it to the top of the menu in the PC JIMS Hub, so that
Hub users could easily duck into the Case Viewer instead of any one of the half‐dozen other options they might have used
in the past. Keyboard users can use Alt/F1 to access it without opening the menu.

ACCESSING THE CASE VIEWER FROM THE EVENT CALENDAR
Judges and/or courtroom clerks may prefer to access the Case Viewer from the Event Calendar. The Event Calendar is a
calendar for court that makes it easy to access the case viewer for any scheduled case. To access the Event Calendar, use
the Event Calendar icon that is in the PC JIMS tool bar. When you come into the calendar, customize it for the
judge/courtroom/must‐appear preferences you have and hit the Refresh button. The calendar will be updated
accordingly. Now, on a day that you see cases, click the number that appears in the calendar. You'll see the cases
scheduled, in time order, in the Events tab. When you want to see one of the cases, just click the hyperlink on the case
number and you'll be taken into the Case Viewer for that case. This is shown in more detail on page 19 of this document.

NAVIGATING THE CASE VIEWER
What you'll see when you open the Case Viewer is a tab for each of the various types of court data. These tabs are
designed for fast viewing, making it easy to navigate through all of the pertinent information while court is taking place.
But additionally, each of the tabs has a hyperlink at the bottom of it that gives users access to the program used to edit
that data. So clerk staff or judicial staff can move from tab to tab, accessing the edit option when they need to add or
change that type of data. So lets take a look at each of the available tabs. Start by maximizing your screen so that we see
as much information as we can in it.

LITIGANT TAB‐‐THE LEFT PANEL
You'll find the title of the case in the left side of the screen at the top.

Below the title, each of the litigants on the case will be listed with their attorneys below them. The litigant address and
attorney information that you see on the right side of the Litigant Tab will change when you click the litigant type and
number for the litigant you want to see. In other words, clicking D 2 or P 1 will change the data on the right side to
be about D 2 or P 1. This is true regardless of which tab you are viewing on the right, so it is the way, for example,
to switch between viewing balance and payment information for each litigant. Don't click the hyperlinked name, as that
will activate the Judici Tab‐‐something we'll get to later in this document.
Initiating emails
(The Email functions in this program only work for users of Microsoft Outlook or other non‐web based email programs.)

If your monitor is large, and your resolution isn't you should see a column on the left panel
titled Email Address and if your county sends emails through PC JIMS, you'll note email
addresses show up there. If you don't see it, your left panel will have a lateral scroll bar at
the bottom. Moving that bar to the right will allow you to see the email column header.
Indicate your intent to initiate an email by check marking the box to the left of that
column header. Doing so will display cc and bcc indicators to the left of the email
addresses.
Click the bcc, and you'll see that it changes to a drop‐down box, where you can select
whether you want to send the email TO a particular email address, or mark them to
receive a copy, or a blind copy.
Once you have the email recipients marked, you're ready to invoke your email editor. To do so,
right‐click on either drop‐down box, or the recipient's name to the left and you'll see a menu
option that says Email. This will open your email editor.

Left Panel Menu
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While the majority of this program tried to do away with menus, we did add a menu for a couple functions you might
want to do in the left panel. Right‐click on a litigant's attorney (noted with the
either edit the attorney, or edit the attorney's address.

icon) and you'll see menu options to

The Edit Attorney Address option is self‐explanatory. It's for changes to the attorney's address or phone numbers. So
let's talk instead about the other option...
The Edit Attorneys option takes you to a screen where attorneys can be changed, or added. If you are replacing the
attorney, type the new name over the name on the top row. If you are adding an attorney, move down to the second row
and start typing the attorney's name. When the drop‐down box shows up, you can use it to select the attorney you want
to add to the case.

Note that if you want changes to attorneys to be logged to the record sheet, you'll want to turn auto‐logging ON in this
program. To do so, checkmark Auto under the Edit/Preferences/Logging menu.
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LITIGANT TAB‐‐THE RIGHT PANEL

The right side of the Litigant Tab shows litigant demographic information, some case status information and attorney
information. While most of the information noted here is obvious, there are some of the items you might be less familiar
with:
Atty capacity‐‐This will note public defender or guardian ad litem if the attorney is not serving as private counsel.
Jury‐‐Notes the presence of a jury demand flag on the case.
Suppressed‐‐When marked with YES, the case minutes have been marked as private to non‐court personnel, or any other
user not authorized by the circuit clerk to see them.
Allow access‐‐This notes access to the public. Values here could be Yes, No or Index Only, meaning that while the names
on the case are allowed to show in the Index, the rest of the case information is secured.
File checked out to‐‐Notes that the paper file has been checked out to someone by the circuit clerk.
Comments‐‐A YES here indicates the presence of case comments‐‐extra notes added by clerk staff. Not all court
personnel are authorized to have access to these comments.

4

Note that on criminal cases, the Litigant Tab will also note the Prosecuting Attorney, as well as arresting agency and
arresting officer.
Hyperlinks: Where you see hyperlinks on this screen, (blue underlined text), it indicates that clicking there will take you to
the program where that data can be changed. The hyperlink on Litigant takes you to the Edit Case screen, whereas
hyperlinks on street or attorney data takes you to the screen where you can update litigant addresses or attorney and
arresting officer addresses. Similarly, the hyperlinks on File checked out to and Comments takes you to a screen where
you can edit that information.
Lastly, at the bottom of the tab, you'll always see a hyperlink that goes to the program where you can edit all of the data
you see on any given tab. On the Litigant Tab, it takes you to the Edit Case screen.

HEARINGS TAB
The Hearings Tab does not require much explanation. A history of the hearings on a case will display in reverse
chronological order. The most recent hearing which took place will be highlighted in an orange font‐‐as will any activity
on other tabs that has taken place since that hearing.

Users who need to add or change a hearing can do so using the Edit Hearings hyperlink at the bottom of the tab.
There is one user preference that can be set from this tab. You'll note under the View menu, an option of Interspersed
Payments. Counties that add payment related hearings to serve as a payment schedule might like to turn this option on.
It will intersperse payments on the case within the hearings, making it easy to note that the litigant has made their
scheduled payments.
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CUSTODY TAB
The Custody Tab will reflect any and all warrant and arrest information.

Users who are unfamiliar with PC JIMS, may need some explanation of this screen. Where the fields here used to have
simple names, like Warrant Date and Arrest Date, users had the need to record data that wasn't specifically warrant or
arrest data. A redesign of the program led to more generic date fields, which, when combined with the Type and Action
Type fields, tell the user what happened.
Issued‐‐The Issued column indicates the date a warrant, or body attachment was issued.
Type‐‐They Type column indicates the type of warrant that was issued, or when used without an Issued date, an
explanation for the Action date. Possible values in this field are:
–
Body Attachment‐‐When the Type is Body Attachment, the Issued date is the date a BA was issued.
–
Contempt‐‐Indicates that the Issued date is the date a Contempt warrant was issued.
–
Fingerprinted‐‐Used without an Issued date to indicate that the Action date is not the date that a warrant was
served, but instead the date the litigant was fingerprinted.
–
FTA and varieties of FTA‐‐Indicates the Issued date is specifically for an FTA warrant of some sort.
–
FTP/CS Admin‐‐Indicates the Issued date is the date of a warrant issued for failure to pay the child support admin
fee.
–
Original Filing‐‐This will appear on the top row only, and won't be accompanied by an Issued date. It indicates
that the Action date is the original arrest date.
PTR‐‐Indicates that the Issued date is the date a warrant was issued for a petition to revoke.
–
–
Other‐‐This is an option that indicates that the Issued date is for a warrant of some other type.
–
Sentencing‐‐This is not accompanied by an Issued date. Instead, it indicates that the Action date is the date a
defendant was remanded into custody to await sentencing.
Action‐‐The Action indicates the date a warrant was no longer in effect, or the date of an arrest or fingerprinting.
Action Type‐‐The Action Type indicates WHY the warrant is no longer in effect. Possible Action Types are:
–
Pending‐‐Used to indicate a pending warrant.
–
Arrested‐‐Used only on the top row, this is indicates the original arrest, when it is made without a warrant.
–
Remanded‐‐Indicates that the Action Date is the date the defendant was remanded into custody.
–
Served‐‐Indicates the date that a warrant was served.
–
Quashed‐‐Indicates that the warrant is no longer in effect. Reasons for a quashed warrant can vary from a
warrant that is withdrawn to a warrant that has expired.
–
Printed‐‐Indicates that the Action Date is the date the defendant was fingerprinted.
–
Vacated‐‐Indicates that a warrant was vacated.
DCN‐‐If the custody row is about an arrest or fingerprinting, you may see a DCN reflected here.
Cash Bond/Other Bond‐‐These will reflect the type of cash or non‐cash bond either posted or set, as a result of a warrant.
Bond Set‐‐Represents the amount that bond was set at, when the warrant was issued.
To EDIT this data, click the Edit Custody hyperlink at the bottom of the tab.
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CHARGES TAB
The next tab to the right differs depending on whether you are looking at a criminal case or a civil case. On a criminal or
quasi‐criminal case, you'll see charges, dispositions and sentences on the CHARGES tab. On a civil case, you'll see civil
dispositions on a DISPOSITIONS tab, assuming the case is a closed one. The data presented on these tabs is fairly
straight‐forward, but there are a few things worthy of noting.

Inchoate‐‐This is a modifier, created by the Administrative Office of Illinois Courts, for use on charges that are attempted,
conspired or solicited. The word "Committed" here simply means that the charge is that the defendant committed the
substantive offense cited. When the inchoate code is something other than Committed, the statute noted will be the
statute for what the defendant conspired or attempted to do. Specifically, the other possible inchoate code are:
Conspired‐‐The charge is conspiracy to commit the offense cited, as defined in the Illinois Compiled Statutes 720
ILCS 5/8‐2 or the Illinois Revised Statutes 38‐8‐2.
Solicited‐‐The charge is solicitation of another to commit the offense cited, as defined in the Illinois Compiled
Statutes 720 ILCS 5/8‐1 or in the Illinois Revised Statutes 38‐8‐1.
Attempt‐‐The charge is attempt to commit the offense cited, as defined in the Illinois Compiled Statutes 720 ILCS
5/8‐4 or in the Illinois Revised Statutes 38‐8‐1.
Conspired/Drug‐‐The charge is conspiracy to commit the offense cited, as defined in the Illinois Compiled
Statutes 720 ILCS 570/405.1.
Conspired/Synth‐‐The charge is conspiracy to commit the offense cited, as defined in the Illinois Compiled
Statutes 720 ILCS 570/405.3.
Conspired/Meth‐‐The charge is conspiracy to commit the offense cited, as defined in the Illinois Compiled
Statutes 720 ILCS 646/65.
ILCS‐‐The hyperlinks on ILCS statutes will take you to those statutes online.
Date‐‐The date you see here reflects the date of the action noted on the row. On a Charge row, it represents the Offense
Date. On a Disposition row, it represents the date of that disposition. And on the Sentence row, it represents the
sentencing date.
MVI‐‐Notes that a motor vehicle was involved in the commission of a charge that would not normally report to the
Secretary of State. Circuit Clerks are advised never to add an MVI code, unless specifically instructed to by an SA or Judge.
Plea‐‐While room did not allow for a full description of this column, its use differs by row. Here's what to expect here:
Charge row‐‐On a row which shows the charge, this column will reflect the plea.
Disposition row‐‐On a row which shows a disposition, this column will reflect the disposition type. The
disposition type is a code used to indicate whether a disposition was a finding, or by verdict or plea. Options here
are Bench, Jury, Guilty Plea, Admission to Delinquency Petition or Court Action (for actions such as Exparte or
Forfeiture).
Sentence status‐‐On a row which shows a sentence, this column will reflect the status of that sentence.
Snt Min‐‐Sentences will be noted in YYY‐MM‐DDD format.
To EDIT this data, click the Edit Charges hyperlink at the bottom of the tab. Users who don't have EDIT authority will be
given a view‐only equivalent of the screen.
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DISPOSITIONS TAB
On Civil cases, instead of a CHARGES tab, you'll see a DISPOSITIONS tab.

The information put forth on the civil disposition tab is fairly straight‐forward, but for newer users, here's what you'll see:
Cmp/Cnt/Dsp‐‐The first three columns show the complaint number and count number for which the disposition was
entered, as well as the disposition number. Since dispositions on complaints are not always handed down in order, you
may see gaps in the complaint or count numbers. (A second complaint, for example, might get dismissed before the first
one.)
For/Agn‐‐These columns reflect the litigant type and number of the litigant for whom the disposition is in favor, or
against.
Complaint Type‐‐Possible complaint types are Original, Amending, Cross‐Claim and Counter‐Claim.
Disposition Type‐‐Possible disposition types are Original, Appealed or Revised.
Date‐‐The date of the disposition will be noted here.
Judgment/Costs/Atty‐‐These columns will indicate monetary amounts ordered in a judgment. Atty is for Attorney fees.
Memo‐‐If a memorandum of judgment has been entered, the date of it will display here.
Satis‐‐If satisfaction of judgment has been recorded, the satisfaction date will display here.

To EDIT this data, click the Edit Dispositions hyperlink at the bottom of the tab. Users who don't have EDIT authority will
be given a view‐only equivalent of the screen.
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PAYMENTS TAB
The Payments tab will show payments made by a litigant.

Payment histories are pretty easy to understand. Perhaps the only non‐evident information is in the first column, which
will reflect a V for vouchers or a B for cash bonds. Other than that, the Receipted column represents the date the clerk
receipted the transaction, while the Reclassed column represents the date a bond was applied.
Once again, as with other tabs, you'll note that activity that has occurred since the last hearing will be represented in an
orange font. This is to draw your activity to items that may be of particular interest.

Note, on civil cases, that you can change which litigant you
are reviewing by clicking, in the left panel of the program, the
litigant type and number for the litigant you want to see. In
other words, clicking D 2 or P 1 will change the
PAYMENTS tab so that it shows the payments made by D 2
or P 1.

To EDIT payment or account data, click the Edit Payments hyperlink at the bottom of the tab. Users who don't have EDIT
authority will be given view‐only access.
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BALANCE TAB
The Balance tab will show fines and costs ordered and paid.

Once again, the information presented here is pretty easy to understand. Looking under the View menu for this screen,
however, will show you two features you may or may not want to use.
View/Disbursement Data
The case shown above is shown with the disbursement data‐‐
namely the recipients of certain ordered costs. In this case, we're
seeing restitution recipient names, and checks issued to them, as
well as the recipient of an FTA Warrant fee.
View/Fee Hyperlinks
Where a fee can be traced to one statute instead of many, the fee
will be hyperlinked to that statute online.
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MINUTES TAB
The Minutes tab is where you'll see the record sheet for the case you're reviewing. Court proceedings and clerk entries
will both display here. Entries will display in reverse chronological order, since users are usually most interested in seeing
the most recent case activity.

Note, on civil cases, that if the Minutes tab is blank, you may
have come to the tab with the wrong litigant in focus.
You can change which litigant has focus by clicking, in the left
panel of the program, the litigant type and number for the
litigant you want to see. In other words, click the D 1 or P
1 if the Minutes tab does not show the docket entries for your
case.

icon on some of the minute entries. Where an entry pertains to a
You'll note the Docs column, which reflects a
document that was filed, that icon will take you directly to that document on the DOCUMENTS tab.

Both clerk and judge users who are authorized to edit the record sheet may do so by clicking the Edit Case Minutes
hyperlink at the bottom of this tab.
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DOCUMENTS TAB
The Documents tab will display the complete list of imaged documents for a case.
As of 3/13/2018 and in any version after 1.42.23, the Support Tab of the Lady Justice screen can now be
used to record an email address for the signed on user. This email address will be used to verify a user's
access to secured cases through the Judici tab of the Case Viewer screen. In order for this to work, we are
going to be offering all counties Extended Access free of charge. If your county hasn’t been set up yet, you
will not see secured documents through the case viewer.

There's not much to see on the screen itself, short of the date the document was scanned, as well as the document name
and document ID. A Secured column reflects a checkmark on any document that has been secured. Similar to the
icon on the Minutes tab, the Documents tab has a

icon that connects you to the docket entry for that document.

To open a document, simply click the hyperlinked document name.

Resizing your document review pane
The first time you open a document in the Case Viewer, the screen size that displays is going to be small. You'll want to
enlarge the screen, in order to more easily view the document. Once you enlarge the screen, and close it again, that will
set the default size for any future documents that you open. While some users might choose to maximize their
document review pane on their first occasion using it, users who want to view multiple documents side‐by‐side will not
want to do this. Maximizing the document review pane would make it impossible to do so.

To enlarge the screen, hover your mouse over the corner of the screen until you see a
and drag it to expand the screen size.
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icon. Then click that corner

The Document Review screen: Options while viewing documents
The Document Review screen gives you access to many common
functions:
At the bottom of the screen, these
arrows will move through the pages to the left or right. Note
will take you to the beginning of the document and

that the
the

icon will take you to the end of it.

This toolbar across the top of the screen gives you many
different options:

The printer icon is of course what you’ll use when you want
to print the document.
These icons change the view to show the
document at its actual size,
screen either in its entirety
width

, or fit the document to the
or in its full length

or

. These are the fastest ways to enlarge a document.

Should you need to rotate a document, these icons will rotate 90° to the left or to the right.
Hover over these three icons and you'll see that the first one says "Single Page". The second one, "One
Column" and the third one, "Two Columns. These are just different ways to view the document. Most recommended is
the One Column format, which gives you a scroll‐bar on the right for moving through a large document faster. If your
view is on Single Page, navigation to the next page must be done using the arrows at the bottom of the screen. There you
can also type a particular page number to move to that specific page.
The Properties icon will show you technical details about the size and location of the document.
The Mouse Drag icon allows you to move a document up or down if you are zoomed in so much that a sidebar scroll
appears.
The Magnifier icons are to zoom in and out of a document.
This icon is for annotating a document—a function that is not available for Notice Generation documents that are
being exported to Imaging.
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JUDICI TAB
You'll note that the Judici tab is greyed out when you first come into the Case Viewer. This is because the Case Viewer
can be about more than one person, which means that you have to activate the tab by indicating which person you want
to look up in Judici. Here's where you use the hyperlinks on the litigant names in the left panel of the program.

You'll see hyperlinks for each litigant
name and or alias name on a case.
(Alias names are noted by the
icon to the left of the name.) Click
the name you want to look up, and
the Judici tab will go to work.

Data might display from any one of the 79 counties in Illinois.

Hyperlinks in the Judici Tab
You'll note hyperlinks in two places of the Judici Tab...
In the Litigant Name column, the hyperlinked name will change your Judici search to be based on the name you click. A
Judici search might be made more specific, for example, if you came in on a case for JOHNSON, MICHAEL and wanted to
switch to searching on the name JOHNSON, MICHAEL A.
In the Case No column, hyperlinks might be noted on cases that are in your own county. For these cases, clicking the Case
No. hyperlink will change the Case Viewer program so that it displays the data from THAT case, instead of the case you
were previously on. This can be very helpful to circuit clerk staff when they need to enter data on companion cases for a
defendant. Closing companion cases, setting up accounts receivables...all of this can be easier by using the Case Viewer's
Judici Tab. To get back to the complete list of cases later, just activate the Judici tab again, in the same way that you did
so the first time.
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CONTENTS OF THE JUDICI TAB
To expand the data for one of these cases, simply double‐click anything on a row that isn't a hyperlink. That case will
expand and all of the data from that county will display:

The Judici tab will show you whatever information is found on Judici for any given case. Charges, dispositions, sentences,
custody records, minute entries...

Even the documents from the other county's cases will be visible to judges and clerk users of PC JIMS! Using the same
document review screen that you are accustomed to using, you can now review the documents from other counties.

Once you've reviewed a case, you can collapse it using the box to the left of the county and case number.
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JUDICI NAME TAB: SEARCHING BY NAME AND DOB
Within the Judici Tab itself, there are several tabs you can use to view Judici data. The default tab which first opens is the
Name tab. This tab will open with the name and date of birth from the case you were on in the Case Viewer. You can
modify your search by changing either one of these. You might, perhaps, want to remove a middle initial from the name,
or broaden your search by removing the date of birth. (Removing the DOB is not recommended for accurate results
though.)

JUDICI CASE TAB: SEARCHING BY CASE NUMBER AND COUNTY
Should you know of a case you need to review in another county, you can come into the Judici tab from any case, and use
the Case tab to pull up any case from any other Judici county.
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JUDICI FILTERS TAB

The Filters tab is designed to be helpful in the courtroom, where information from cases in other counties might be
useful. It will be an option any time the search results for a given name and date of birth produce 50 or less cases. Any
more cases than that will cause it to be deactivated, as such volume in the searches could affect performance.
Judici Filters Tab‐‐The Quick Look tool
Options on the Judici Filters tab include a Quick Look drop‐down, which can be used to identify cases that meet a certain
data requirement that interests you. When cases qualify for the criterion you choose, the case will be highlighted in
yellow. If it is necessary in order to see the data you're looking for, the case will be expanded, to display the data of
interest. Users can choose one Quick Look option after another though, and cases will expand or collapse, depending
upon whether they meet that particular search requirement.
Note that when we talk about "expanding" or "collapsing" a case, it is referring to whether the case is listed in its most
simple form, looking something like this:

Or whether it has been expanded in order to show you the case data in its entirety, showing all of the case data previously
described.
The Quick Look drop‐down gives you these search options:
Unpaid‐‐Using this option will highlight unpaid balances in the far‐right balance
column. (Note, however, that depending upon your resolution, you may need to
move your lateral scroll‐bar to the right to see the balance column.)
Pending‐‐Using the Pending option will result in the expansion of all of the cases
that are pending, leaving closed cases collapsed.
Warrant‐‐When a case has an outstanding warrant, the litigant name will display in
a red font. A quick‐look search for cases with outstanding warrants is therefore
only needed if you want to more closely review data on the cases that have
outstanding warrants.
Current hearing‐‐Use this at times when you need to check whether a litigant is due in court in another county. Cases
with current hearings will expand, and the current hearing will be highlighted in yellow. Use your vertical scroll‐bar to
scroll through the data, looking for the highlighted entries.
Supervision‐‐In situations where granting supervision multiple times is a risk, use this option to see if a litigant has gotten
supervision in any of the other Judici counties. Cases with supervision will expand, and the supervision sentence will be
highlighted in yellow. Use your vertical scroll‐bar to scroll through the data, looking for the highlighted entries.
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Probation‐‐Similar to the Supervision option, this option will expand and highlight probation sentences on any of the
cases shown.
Revocation‐‐This option will display and highlight Revocation dispositions, should they appear on any of the cases in your
search results.
Local‐‐For defendants with many cases in your county, this option might overwhelm a user. Its purpose is to expand ALL
of the cases that are local to your county, leaving the out‐of‐county cases in their collapsed state.
Out‐of‐County‐‐A reverse of the last option, this one expands all of the out‐of‐county cases, leaving your local cases in
their collapsed state.

Judici Filters Tab‐‐Searching by row type and text
Also on the Filters tab is the option to search for any word, in any specified on non‐specified row of data. To do this you'll
want to use the Row Type drop‐down and the Find text box.

The Row type drop‐down enables you to specify that you're looking for a word or
words in either the case level (case number, litigant name, litigant DOB etc.) or
the charges, dispositions or sentences. Using ANY in this drop‐down will locate
the text in any row, including the docket entries and document names.

The possibilities are endless! Search the Charge row to see all of the charges of BATTERY, for example. Or search the
Disposition row to search only for those cases that received a verdict of GUILTY. Or search the sentence row for
sentences of particular interest. Or, use the Any option for word searches of another sort. For example, are you curious
whether a defendant has failed to appear in another court while out on bail? Search for text of FTA, using the ANY
option, and you'll be able to see docket entries that note FTA, or warrants that are of the FTA type. Concerned about the
abbreviation? Search for "failure to appear" too, just to be sure.
Inverse Find‐‐Using this option will cause the expansion of any case that does NOT have the identified piece of text.
Searching the Disposition row for "Dismiss" for example, and using the Inverse Find option would result in any case that
was NOT dismissed being expanded, while all of the dismissed cases stay in their collapsed state.
Case sensitive‐‐Using this option simply narrows your search results down to those cases that have the search text you
specify, in the upper and lowercase letters that you have specifically provided. This will greatly reduce your search
results.
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ACCESSING THE CASE VIEWER FROM THE EVENT CALENDAR
Judges and/or courtroom clerks may prefer to access the Case Viewer from the Event Calendar. The Event Calendar is a
calendar for court that makes it easy to access the case viewer for any scheduled case. To access the Event Calendar, use
the Event Calendar icon that is in the PC JIMS tool bar.

At the bottom of the screen, you fill out which judge's schedule you want to see, and whether you want the morning
cases, the afternoon cases or both. The must‐appear option can limit what you see to exclude traffic may‐appear cases in
any county that sets may‐appear cases in the manner in which we train users to set them. (Hearings without either the
judge and/or the courtroom will be considered may‐appear hearings.)

Then, when you hit the Refresh button, the calendar will display the number of hearings or other events the judge has
scheduled during the morning or afternoon on each day.
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To see the cases that are set for that day, just click the hyperlink on the number of hearings. The event tab at the bottom
of the screen will show the specific cases that are set for that day:

And from here, clicking on the hyperlinked case number will take you into the Case Viewer for that case...
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Note: As of 03/13/2018 and in version 1.42.23 and higher, the event calendar has a new option under the Edit/Preferences
menu to view the program in a landscape view. This was done because we encountered some trouble with pc's that were
set to a larger resolution. In the landscape view, the cases and events will display to the right of the calendar, instead of at
the bottom. Like this:
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